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Notes

This user manual is a guide to the research product BESA MRI — a stand-alone software program.

The manual introduces the features, workflows, and the main windows and dialogs of the BESA MRI
software. A help function is provided within the software. Press F1 on the keyboard or select menu item
Help - BESA MRI Help for help.

Before starting to work with BESA MR, please read this user manual carefully.

Please report any suggestions and errors found in this manual via email to feedback@besa.de

BESA GmbH provides support to all customers who have purchased BESA MRI directly from our sales
office (sales@besa.de) or through our distributors.

BESA GmbH
Freihamer Str. 18
82166 Grafelfing - Germany

E-mail: mri-support@besa.de

Symbols

Follow the instructions in this manual to prevent damage resulting from misuse
of the program. In addition, this symbol marks important sections that shall be
read before starting to work with BESA MRI.

This symbol indicates potential risks for users of BESA MRI or third parties if
the product is not used as intended.
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1. Indications for Use

BESA MRI is a software-only product compatible with personal computers running under a Windows
operating system or an emulator thereof. The software is intended to help users visualize and analyze
electrical activity of the human brain by fusing a variety of previously acquired, adult or pediatric (= 10
years of age), electroencephalographic (EEG) and/or magnetoencephalographic (MEG) data with
Magnetic Resonance (MRI) and/or Computed Tomography (CT) images. The intended user is a qualified
neuroscientist who will exercise professional judgement in using the information.

The segmentation component of BESA MRI imports digital MRI data, segments and labels different brain
tissues, transforms the MRI data into ACPC- and Talairach spaces, and renders the scalp and cortical
surfaces.

The coregistration component of BESA MRI imports EEG electrode and/or MEG sensor coordinates and
fits these to the scalp surface provided by the segmentation component.

The device does not provide any diagnostic conclusion about the subject’s condition.

It is not allowed to use the BESA MRI software directly or indirectly for medical diagnosis and/or
treatment of humans. MEGIS is not liable for the use of the software beyond the intended research
purpose.

The BESA MRI software is licensed for research use only.
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2. Introduction

2.1. Features of BESA MRI

The BESA MRI software provides optimized, user-guided workflows to read and transform MRI data to
ACPC- and Talairach space, reconstruct the scalp and cortical surfaces, and coregister electrode and
MEG sensor coordinates as well as skin markers with the individual scalp.

The key features of the BESA MRI software are:

¢ Import of MRI data using an automated DICOM reader

o Easy definition of ACPC- and Talairach points and other markers

e Automated inhomogeneity correction and reconstruction of individual scalp and cortical surfaces

e Transformation to ACPC- and Talairach space by direct 3D-spline interpolation of the original MRI

o Easy coregistration of digitized electrodes, MEG sensors, and skin markers with individual MRI data
e Morphing of standard electrodes (10-20 or 10-10 system) to the individual scalp

e Output of coregistration and MR files for source analysis programs, e.g. BESA Research

The integrated segmentation workflow guides quickly through the necessary initial steps of data
preparation from the input of the MRI data to the marking of all reference points. Then, an automatic
finalization process performs the preset correction, segmentation, and reconstruction steps and presents
the final results for inspection. It is possible to prepare MRI data of several subjects for segmentation and,
then, start the automatic finalization of all projects in one step.

The integrated coregistration workflow guides quickly through the loading of a completed segmentation
project and of a coregistration file, helps to set fiducial markers, and fits electrodes and/or MEG sensor
coordinates as well as skin points to the scalp surface for final inspection.

This workflow concept (see chapter 4) allows for the immediate review of each workstep in the Workflow
Window (see chapter 5), and for the modification of specific parameters and the recalculation of the
output data if needed.

The segmentation and coregistration worksteps are described in detail in chapter 6, along with more
details on how to use BESA MRI.

BESA MRI provides a subject-based data management (see chapter 0). All results are stored in subject-
related subfolders. Several segmentation and coregistration projects can be managed for each subject.
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2.2. Product Classification

According to MDD 93/42/EEC, Annex IX, rule 10, BESA MRI is a Class lla software product for the
preprocessing and segmentation of human scalp MRI data stored on computer disk.

According to safety classifications in DIN/EN IEC 62304:2006, BESA MRl is a Class A product (class A:
no injury or damage to health is possible).

The product is noninvasive since it is stand-alone software and does not control any equipment physically
connected to the patient. It is designed purely for data analysis. No physical devices are controlled or
driven by BESA MRI, nor is any active feedback provided to the patient. Any direct physical damage to
the patient, for example, during the recording of data, can therefore be excluded.

According to DIN EN IEC 60601-1:2005, BESA MRI does not affect the possibility of using the computer
within the patient environment. BESA MRI does not interfere with other programs or hardware connected
to the computer (third-party equipment)

According to UMDNS/DIMDI, BESA MRl is classified with the following codes:

UMDNS code: 16-307
GMDN code: CT112 (Software, application program)

2.3. Certification

CEn

The CE marking certifies that this product fulfills the basic requirements of the Medical Devices Directive
MDD 93/42/EEC.

The number 1275 represents the identification number of the Notified Body that carried out testing and
certification.

2.4. System Requirements

e Operating system: Windows® 7
Windows® Vista

Windows® XP Service Pack 2

e CPU: Minimum 2 GHz

e RAM: Minimum 2 GB

e Display resolution: Minimum 1280x800 pixels

e Graphics card: OpenGL 1.1 with 16 MB RAM or more
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2.5. Application Environment

If the product is installed on a PC or Notebook within the patient environment, the PC/Notebook must
conform either to DIN EN IEC 60601-1 medical PC or must be isolated from the patient by means of
protection (IEC 60601-1 3¢ Edition) e.g. by an isolating transformer fixed at the PC, or mobile isolating
devices for Notebooks.

The patient environment is defined as follows:

2.6. Disposal Information

The BESA dongle and the BESA MRI CD must be disposed of according to the national guidelines on
environmental protection.
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3. Installation and Initial Setup

The installation and initial setup of BESA MRI must be carried out by an administrator or an experienced
technician. Chapter 3.1 illustrates the installation process, and chapter 3.2 introduces the initial setup of
BESA MRI.

The installation of the product must be carried out by the system administrator or an
authorized person.

Product updates must also be carried out by the system administrator or an authorized
person.

After installation and setup are complete, please submit this user manual to all users of the
program.

If the product is installed on a PC or Notebook within the patient environment, the
PC/Notebook must conform either to DIN EN IEC 60601-1 medical PC or must be isolated
from the patient by means of protection (IEC 60601-1 3™ Edition) e.g. by an isolating
transformer fixed at the PC, or mobile isolating devices for Notebooks.

3.1.

3.2.

Installation

Start Windows and insert the installation disk into the CD-ROM drive.

If the PC permits auto start from the CD drive, the installation starts automatically after a short
time. If the PC does not permit auto start, please run from the CD. The file is located in
the folder.

Please follow the on-screen instructions.

Once the installation is complete, proceed with the initial setup as explained in the following
chapter.

Initial setup

This section explains the steps to be done for an initial setup of BESA MRI.

3.2.1. Connect the BESA Dongle

BESA MRI is protected by a licensing scheme developed by Aladdin Knowledge Systems. During the
installation as explained in chapter 3.1 the device drivers for the BESA dongles will be installed
automatically.

Connect the BESA dongle to your personal computer or a server machine and proceed with the next
step. If required, check for correct installation as described below.

If the dongle is installed correctly, the Windows Device Manager reports three items in the “Universal
Serial Bus controllers” section: Aladdin HASP HL Key, Aladdin HASP Key and Aladdin USB Key.

- E‘& Universal Serial Bus controllers

Aladdin HASP HL Key
Aladdin HASP Key
Aladdin U3E Key

11



The Aladdin HASP key installer includes the HASP License Manager application:

When this application is running, you should be able to load the HASP License Manager Admin Control
Center by typing http://localhost: 1947 in your internet browser. The connected dongle should be

displayed there. If you do not see the dongle, please wait a few seconds.

r — .1
3 HASP SRM Admin Control Center: HASP Keys - Mozilla, Firefox |’._||E|r'5__<|
File Edit Yiew Higtory Bookmarks Tools  Help
@ = c (at I A http:fflocalhost: 1947)_ink_fdevices.html M ‘ )

HASP Keys available on
Options # | Location | Wendor | HASP Key ID | Key Type “ersion | Sessions | Actions

Froducts | | Featl
HASP Keys 1|Local | ywoxE | 123486780 |IASETE gyl 5 | EED D
 Praducts Sessions || Blink an
Frature v

Done

If the dongle is not installed correctly, one of the following message boxes is displayed when the program
is started.

HASP SRM Protection System rg|

@ HASP ke not Found @ IUnable to access HASP SRM Run-time Environment;

HASP SR Protection System

The message box on the left appears for one of the following reasons:

e The BESA dongle is not connected.
Solution: Ensure that the key is accessible in order to run the program.
e USB port is defective.

Solution: Check if the LED is lit on the HASP Protection Key. If not, remove and re-insert. Wait for
the operating system to detect the device. If it still does not light up, try another USB port.

e Faulty dongle.

Solution: On rare occasions, the HASP Protection Keys may be faulty. The dongle does not light up
in this case and is not detected in the Device Manager. Request a replacement dongle.

The above right message box comes up for one of the following reasons:
. is blocked by a firewall or an anti-virus application.

Solution: Add in the exception list of the anti-virus and
firewall applications.

e Port 1947 is blocked by a firewall application.
Solution: Add port 1947 to the exception list of the firewall application.
e HASP License Manager Service is stopped.

Solution: Restart the HASP License Manager Service (Control Panel - Administrative Tools 2>
Services)

12



3.2.2. Start the Program

g } Start BESA MRI using the shortcut created on the desktop or run
from the All Programs - BESA - MRI 1.0 folder in Startup menu.
Besa MRI.exe First, the Welcome Screen appears (cf. 6.1.1). Press Accept to start BESA MRI.

3.2.3. Specify the BESA MRI Data Folder

As initial configuration step, the BESA MRI Data Folder must be specified (for details cf. 7.1). This is the
folder where BESA MRI stores all project and result data to and reads from (typically on the server).

When starting the program for the first time, the following dialog box appears:

Select the BESA MRI Data Folder

Flease select the BESA MRI Data Folder
All project data will be saved to this folder.

Mote: If needed, you may switch between diffierent BESA MRI Data folders using the menu itermn
File — Select Data Folder’,

C:hDocuments and Settings\AIl Users\Docurments\BESA MRProjectsh | I Edit ]

The BESA MRI Data Folder is preselected to All Users on the local PC (shown above for Windows XP).
However, it is recommended to create the BESA MRI Data Folder on your server where it is accessible to
all users from anywhere in the local network. For more details, see chapters 6.4.1 and 7.1.

Press the OK button if you want to use the preselected local folder in All Users.

Press the Edit button to create your BESA MRI Data Folder elsewhere, e.g. on the server 7:\ as below:

Select the BESA MRI Data Folder

Lok, in; | Z# Data on Fileserver!' (2] V| Q ? & -
LY MName Size  Tvpe
uﬁ 'BESA MRI Data File Folder
My Recent [CDIDICOM DATA File Folder
Documents
(1
Deskiop

ty Documents

< | )
My Computer
File: narme:
g Files of type:
by Metwark, Recent Folders: Shared D ata Folder w |

13



When the selection is accepted, the following confirmation dialog appears:

BESA MRI 3

The BESA MRI Data Folder has been selected successfully.
Project data will be written to and read from folder
ChDocuments and SettingsiAll Users\Documents\BESA MREMrojectsh

Update Data Folder Info

Press the OK button.
BESA MRI is now configured to start projects.
Notes:

1. The procedure to define the shared BESA MRI Data folder on the server needs to be carried out only
once at each PC where you install BESA MR, i.e. when starting the program for the first time.

2. When switching between BESA MRI Data folders, it is recommended to leave the tick mark on to
update all existing projects in the new BESA MRI Data folder (cf. 7.1).

14
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4. The Workflow Concept

BESA MRI uses a modern workflow concept that guides you through all the worksteps needed to
complete a project, suggests and explains necessary inputs and user actions, and performs many
worksteps automatically. At any time, you may interrupt and inspect earlier worksteps or redo them with
modified input parameters if required.

18 0058 M1 1.0 Swbject 01 [1960.01.01) - Mit_T1 (Sepmentation project]

Cortex Segmentation B E S A
. -

The workflow window at the left of the BESA MRI screen shown above depicts all the steps of the
workflow in a segmentation project - completed up to the segmentation of the cortical surface.

A workflow consists of a series of worksteps that have to be done to finalize a project. Each workstep
realizes a set of user interactions needed to achieve the workstep-specific result. Some worksteps can be
run in automated processing mode with preset parameters, e.g. inhomogeneity correction and
segmentation. Thus, only a few user interactions are needed during the initial worksteps.

When pressing the Next button or Space a workstep is terminated and the next workstep is loaded. Thus,
the workflow of a project proceeds sequentially workstep by workstep.

As described in chapter 5, the layout of BESA MRI screen is optimized for this workflow concept. The
workflow menu - as shown on the left in the Workflow Window - gives an overview over all the
worksteps to be done in the selected project (cf. 5.1). The workflow menu can be used to switch between
the worksteps. For example, you may redo an earlier step with different or advanced parameters and
continue with automatic processing of all subsequent steps as defined before.

The current results during a workstep are shown in the Main Window in the middle (cf. 5.2). The
Information Window below (cf. 5.4) provides advice and help information for the current workstep.

During each workstep a special dialog is shown in the Interaction Window on the right to allow for
optimized user interaction relevant for the current workstep (cf. 5.3). The interactions required during a
workstep are grouped starting at the top and ending at the bottom of the Interaction Window. After
completing all interactions, press the Next button at the bottom or Space to proceed to the next workstep.
Press the Previous button to go back one workstep. After completing the last workstep of the workflow,
press the Finish button at the bottom of the Interaction Window to save all data created during the
project. This allows reloading the full workflow of a project with all worksteps at any time later.

15
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BESA MRI offers two different workflows associated with the following projects:
Segmentation Project: Initiated by Start New Segmentation Project (figure on previous page, cf. 6.2.1).

Coregistration Project: Initiated by Start New Coregistration Project (figure above, cf. 6.2.2).

A project is defined by a specific workflow together with the stored individual input and output data.
Therefore, projects are identified by the name and birth date of an individual subject along with the type of
workflow specific for the project, i.e. Segmentation or Coregistration.

Stored projects can be viewed by selecting the menu item File - Open Project, using the open button in
the toolbar, or pressing the Open Segmentation / Coregistration Project buttons on the start screen.
After opening a stored completed project, the final workflow result is displayed in a special viewer
workstep (see screen below for a Segmentation project):

=]

960 MI_TY {Segmentation project] =
e
e " BESA

Selet main window daplay

ALPE Transtomed Data

0o @

Talarsch Tramplermad Duta

CI ]

Hints: Drag fo rotate the image. Mave | Zoom the 30 surface image by dragging whils holding down the Cirl / - Close Woddy

To modify the project or to review the completed worksteps, reload the workflow by pressing the Modify
button.

16
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5. Elements of the BESA MRI Screen

The layout of BESA MRI screen is optimized for the workflow concept as described in chapter 4. The
figure below shows the BESA MRI screen with all its elements:

{8 BESA MR 1,0 - Nesw Segmentation project e !
Fie Edt Vew Hep e
Read MRI Data @ BESA
= )

‘Workilow Ovendew

Sat Project Tagets v

Import Data
Road MR Data
Transformation

Diata Cornction

Segmentation

Finalize Projoct

Workflow Window (see chapter 5.1)
Main Window (see chapter 5.2)
Interaction Window (see chapter 5.3)

Information Window (see chapter 5.4)

Menu Bar (see chapter 5.5)
Title Bar (see chapter 5.6)
Toolbar (see chapter 5.7)
Caption (see chapter 5.8)

OICIOIOICIOIONS,

17



5.1. Workflow Window | /\S B E SA

5.1. Workflow Window

The Workflow Window on the left displays the workflow menu. The workflow menu gives an overview
over the sequential steps needed to finish the current project (for details on the steps cf. 6.2). Steps
already completed are marked with a green OK sign. .z

The current workstep is highlighted. This step is also shown in the caption.

The workflow menu can be used like any other menu to jump to another workstep provided that the
previous worksteps have already been completed.

5.2. Main Window

The Main Window area displays the results of the current workstep. A detailed description how to use the
elements shown in this window is given in chapter 6.3.

5.3. Interaction Window

The Interaction Window provides the user interaction for the

current workstep. In some worksteps a red marker illustrates
*‘—CD the current interaction to be done at the top of the Interaction
Select RP @)= Window.
righitmeet vl - The upper interaction elements are used to set parameters
_— needed in the workstep by using standard elements like
et 195.5 buttons, edit boxes, and sliders. The effect of changing
Modify 105.5 parameters is seen in the Main Window left of the Interaction
Maodify Z: 128.5 Window.

The substep buttons below describe the substeps to be taken
within the workstep. The current substep is highlighted. After a
step is completed, a green OK sign appears beside the
corresponding substep button. +

Set AP (anterior point)

Set PP (posterior point)

Set SP (superior point)

Current parameters are accepted by typing Space, by pressing
the Next button at the bottom or the next substep button (in this
example the Set RP (rightmost point) button).

L4444

Set [P {inferior point)

Set RP (rightrnost point)

Thus, the workflow proceeds to the next substep or workstep

Set LP {leftrmost point) automatically

The Previous button is used to jump back to the last substep or

Display settings to the last workstep, respectively.
Brightness: Notes:
20 J 1. Most parameters are set more conveniently by mouse
Contrast: interactions with the displays in the Main Window (cf. 6.3).
el J 2. To change parameters of a completed substep, unpress the
corresponding interaction button.
ZLoom factor 3. You can undo or redo a substep or workstep also using the
menu items Edit - Undo and Edit = Redo or by typing
20 J Ctrl-Z or Ctrl-Y.

4. Moving on to the next substep or workstep is fastest by

| Previous || Mewt | typing Space or Enter.

18
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5.4. Information Window

The information window displays a comprehensive help text related to the current workstep. The help
texts provide additional information, e.g. which file has been loaded. They suggest and explain the next
user interaction to be done in the current workstep.

The Main Wyindow lists the targets to be achieved by the waorkflow:
To continue the workflow, you can always type Space or Enter or press the Next button.

For more information see description of the Segrmentation Wwarkflow.

Underlined text in blue provides a hyperlink. Click on such a link to open the BESA MRI help at the
indicated topic.

5.5. Menu Bar

The Menu Bar provides the menus listed below. Click on a menu to be selected and choose from the
menu items that pop up.

5.5.1. File Menu

The File menu contains functions related to the data management (cf. 0). It contains the following items:

File menu item Description

Create New Project Start a new project.

Open Project Load an existing project (cf. 6.4.2).

Close Project Close currently active project. Show the Select Project Page (cf. 6.1.2).
Save Save the currently active project.

Save As... Specify a filename for currently active project and save it (cf. 6.4.3).
Delete Projects... Select one or multiple projects that shall be deleted (cf. 6.4.4).

Select Data Folder Select the folder to be used as BESA MRI Data Folder (cf. 7.1).
Update Data Folder Info Update the information file in the BESA MRI Data Folder (cf. 7.2).

Exit Terminate the BESA MRI program.

19



5.6. Title Bar

1 1BESA

5.5.2. Edit Menu

The Edit menu contains the following items:

Edit menu item

Description

Undo

Undo the last step completed in the current workstep.

Redo

Redo the last step that was undone in the current workstep.

Finalize Current Project

Start an automatic finalization of the currently active workflow. This
menu item is only enabled, after a workflow state has been reached at
which all data is prepared for automatic finalization.

Finalize All Segmentation
Projects

Start a finalization of all segmentation projects that are prepared for
automatic finalization and defined in the current BESA MRI Data folder.

5.5.3. View Menu

The View menu can be used to change display settings for BESA MRI. It contains the following entries:

View menu item

Description

Show Workflow Window

By selecting or deselecting this menu item the Workflow Menu is
displayed or hidden (cf. 5.1).

Show Information Window

By selecting or deselecting this menu item the Information Window is
displayed or hidden (cf. 5.4).

Standard Font Size,
Large Font Size,
Extra Large Font Size

Select one of these menu items to specify the size of the font to be
used in BESA MRI.

5.5.4. Help Menu

Use the Help menu to open the program help or to get information about BESA MRI.

Help menu item

Description

BESA MRI Help Open the program help.
About... Get information about the current program version.
5.6. Title Bar

The title bar of BESA MRI displays the program name and version number. In addition, it shows the
following information on the current project:

e Subject information (subject name and birthday)

e Project name (if specified)

e Project type (segmentation or coregistration project)

20




5.7. Toolbar

The Toolbar provides direct access to the most important menu items:
File > Create New Project

File > Open Project

File > Close Project

File > Save Project

Edit » Undo

Edit » Redo

R 5 @ L O C

5.8. Caption

The caption is located between the Menu Bar and the Toolbar and specifies the current workstep.

21
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6. How to use BESA MR

Before working with BESA MRI, please read chapter 4 on the workflow concept. Consult chapter 5 on the
elements of the BESA MRI screen while starting to use the program.

6.1. Starting BESA MRI

6.1.1. Welcome Screen

Start BESA MRI from its icon on the desktop or from BESA Research during the coregistration process.

When starting BESA MRI, a welcome screen appears. It provides some information on the BESA MRI
program including the current version number and date:

BESA® Version 1.0 December 2010

IVI R I BESA GmbH, 82166 Graefelfing, Germany
Copyright © 2010 - all rights reserved.

mputer
. including all

For research use onhy!
Not for the use in diagnostic procedures!
Please read the User Manual before first use!

Ifyau accept the licensing canditions, click ept', elze cl

I .

Press Accept to start BESA MRI.

23



6.1.2. The Select Project Page
After starting BESA MRI, the page Select Project shows. It allows to select a specific workflow:

@ BEsa il 1.0 9=

Fie Edl Vew Help

Select Project 1) B E SA
| )

Stant Warkdlow

Srart Now Segmentarion To propare and segment MRI data, preas the Stan Now Segmortation’ Ston New Segmeeddtion |
Select Project button, [ Stan New Cosegistration J
The sagmentation workfiow wel guide you through the necessary steps e —
Open Segmentation Project |
Stan New Coreglstration To coregister electrodes / MEG sensors snd head surfice poins to MRI
data, press the Stan New Coregistration’ button after completing MRI | Opirn Corgritration Project J
segmirtation

The coregratration workfiow wil guide you thiough the necessary sleps
Open Seqmentation Project To tedoad an gxsslng segmentalion project, prevs the Upen
‘Segmentation Project’ bution
You can da this 1o view or modify the selected project
Open Corsgheration Project To redosd an exieting coreqistration projact, press the Open

Catgistration Progect’ butlan
Yous can da this o wew of moddy the selected project

Sebect projoct by perssing one of the buttens in the |nteraction Windsre

For moee infoemation 2ee description of the Salect Project Page

Press one of the buttons in the Interaction Window on the right to start the desired project and the related
workflow.

Press Start New Segmentation to create a new segmentation project. The Segmentation Workflow
opens (cf. 6.2.1).

Press Start New Coregistration to create a new coregistration project. The Coregistration Workflow
opens (cf. 6.2.2).

Press Open Segmentation Project to load an existing segmentation project. If the selected project has
been finished, the View Results screen opens (cf. 4).

Press Open Coregistration Project to load an existing coregistration project. If the selected project has
been finished, the View Results screen opens (cf. 4).

Notes:

1. Before coregistration can be started for a subject, at least one MRI segmentation project has to be
finished for this subject.

2. Projects can also be started or opened at any time by selecting the menu items File > Create New
Project or File > Open Project.
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6.2. The Workflows of BESA MRI

6.2.1. The Segmentation Workflow

The Segmentation Workflow realizes the preparation and correction of individual MRI data, the
segmentation of the different head tissues for finite element modeling (FEM), and the rendering of scalp
and cortical surfaces. The Segmentation Workflow consists of the following worksteps:

6.2.1.1. Set Project Targets

The first workstep gives an overview over the worksteps that have to be done to complete the loaded
workflow. Grayed tick marks indicate obligatory worksteps, black tick marks relate to optional worksteps.

Type Space or press Next to continue the workflow.

6.2.1.2. Read MRI Data

In this workstep, the MRI data is imported. Select the subject’'s MRI folder and one of the files of the
DICOM data set to be processed. BESA MRI loads all files of the same imaging sequence stored in the
selected folder. Slice data files are read in, sorted, and oriented automatically.

The MRI data is read and oriented automatically based on the official DICOM standards. To
avoid left-right permutation, application of a side marker for MRI acquisition is recommended.

The header information of the DICOM files is evaluated and displayed in the Main Window. Check if
subject and sequence are correct and type Space or press Next to continue the workflow.

Note: The original MRI data and header information are stored with other project data in an internal
format in the BESA MRI Data Folder under the subject name and the project name. This allows to reload
the project data later independently of the original DICOM data.

6.2.1.3. Set ACPC Transformation

In this workstep, the transformation of the original data into the ACPC coordinate system is defined by
marking the middle of the anterior commissure (AC) and rotating the MRI data set to obtain an optimal
view of the ACPC plane (PC=posterior commissure) and the best separation of both hemispheres by the
sagittal plane.

In the first substep, the position of the AC (anterior commissure) is set by dragging the slices in the
lower half of the Main Window such that the AC midpoint meets the crosshair (for dragging slices cf.
6.3.1). You may also adjust the crosshair in half millimeter steps using the interaction elements in the
Interaction Window on the right.

Type Space or press Next to set and confirm the AC position and continue with the second step.

In the second substep, ACPC rotation is set by rotating the MRI slices such that a) the PC midpoint
appears on the crosshair line behind the AC position and b) the sagittal plane separates the two
hemispheres optimally. Rotation is most easily done by dragging the lower slices in the Main Window
while checking the upper slices for separation of the hemispheres. You may also use the controls in the
Interaction Window on the right to set the three rotations, but this is less convenient.

Type Space or press Next to confirm the PC position & sagittal plane and continue with the third step.

In the third substep, the position of the PC (posterior commissure) is set by dragging the lower left slice
in the Main Window such that the PC midpoint meets the horizontal bar of the crosshair.

Type Space or press Next to inspect the final ACPC transformation. Readjust if needed by pressing the
required substep buttons on the right.

Note: The display settings and the zoom factor can be adjusted at any time at the bottom of the
Interaction Window for optimal viewing of the MRI data. For example, you may increase the zoom factor
to 2.5 or 3.0, unpress the AC (anterior commissure) substep button to readjust the AC midpoint and
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observe that the following rotation and PC setting steps have been preserved. They can be readjusted in
the same way to have an optimal definition of the ACPC transformation.

Type Space or press Next to continue the workflow and move on to the next workstep.

6.2.1.4. Set Talairach Transformation

In this workstep, the brain boundaries have to be set by the user to enable a Talairach Transformation of
the original MRI. This transformation is needed for various masks during segmentation.

During this workstep, one of the six brain boundaries is set in each substep. It is easiest to drag the slice
as listed below while observing the cortical gyri disappear and reappear in the cutoff slice to view:

Substep to set Drag slice View slice Check cortical boundary at
AP (anterior point) Transversal Coronal Frontal brain

PP (posterior point) Transversal Coronal Occipital brain

SP (superior point) Coronal Transversal Top gyri

IP (inferior point) Coronal Transversal Temporal poles

LP (leftmost point) Coronal Sagittal Lateral temporal cortex
RP (rightmost point) Coronal Sagittal Lateral temporal cortex

It can be helpful to click into the outermost gyri in the cutoff slice for better viewing in the other slices.

Type Space or press Next to proceed step by step. Follow the instructions in the Information Window.

6.2.1.5. Set Markers
In this workstep several markers are set as input for the following automated segmentation worksteps.

In each substep, Click onto the requested region as described and illustrated below. A red marker
appears. You may drag this marker to adjust. Type Space or press Next to confirm the position and
conclude the substep. The accepted marker is now shown in blue.

Alternatively, you may Double Click onto the requested region. The marker will appear in blue
immediately and the workflow proceeds to the next substep.

Corrections can be made by unpressing any substep button in the Interaction Window on the right and
typing Space or pressing Next to continue. For more details on setting or modifying markers cf. 6.3.2.

In the first two substeps, the positions of the nasion and the inion are set. These positions are needed
for the segmentation of the skull.

In the third substep white matter is marked in the brainstem and medulla oblongata by three to five
markers. Set the markers equally spaced from top to bottom. The markers identify the gray values of the
white matter at the lower portion of the head and are needed as input for the automated inhomogeneity
correction. Make sure you mark only white matter portions.

In the last and fourth substep a cutting plane is specified by two markers. All parts below this cutting
plane will be cut off during Scalp Segmentation. The cutting plane can be moved up and down by
dragging the left marker. By dragging the right marker, a different cutting angle can be set.

In the figure on the next page, the Set Markers workstep is illustrated at its end before confirming the
Cutting Plane.
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6.2.1.6. Automatic Finalization

With the completion of this and the previous worksteps, all steps needing your input have been done and
the MRI data preparation is complete.

Therefore, BESA MRI offers the option to continue with Automatic Finalization of the segmentation project
or to follow and adjust the segmentation process step by step. For most data sets, adequate
segmentation output is generated using the default parameters of the Automatic Finalization.

Thus, at the beginning of the correction and segmentation worksteps, you have the following options:

BESA MRI X

MRI data preparation is complete.
Please select the next action:

(®) Start automatic finalization of the segmentation.
() Continue the current segmentation step by step.
() Quit to prepare MRI data of another subject.

() Finalize all unfinished segmentation projects.

Detailed description of the selected item:

Starts the automatic finalization of the current segmentation project using default
parameters.

Mote: ¥ou may start finalization of all unfinished segmentation projects later using
the menu iterm 'Edit — Start Automatic Finalization'.

0K ] [ Cancel

Since the correction and segmentation worksteps take about 20-30 minutes per MRI data set, it is
recommended to use Automatic Finalization and inspect the results before deciding whether parameter
adjustment is needed.

If the default segmentation results are inadequate, you may return to the segmentation worksteps using
the Workflow Window or by pressing the Previous button. Then, modify the required segmentation
parameter(s) and continue the segmentation step by step.
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Another advantage of Automatic Finalization is that you can prepare several individual MRI data sets for
finalization and work on other tasks while all prepared projects are being finalized automatically. It takes
only about 5 minutes to prepare one MRI data set.

When automatic finalization is running, it may be interrupted at any time by pressing the Cancel button in
the progress bar:

BESA MRI

Running automatic project finalization. ..

[ L 1] ] ] I Cancel l

The current workstep will be completed automatically, but it can also be canceled at the lower right of the
Information Window, e.g. to change the number of iterations during inhomogeneity correction.

Running inhormogeneity correction. ..
[ ........ ] 18%

LT T T T T T T T T e

When doing correction and/or segmentation step by step, automatic finalization can be restarted at any
time pressing the Automatic Finalization button at the lower right of the Interaction window, by pressing
the F9 key, or by selecting the menu item Edit > Finalize Current Project (or All Segmentation
Projects).

6.2.1.7. Inhomogeneity Correction

The gray values of the white matter are not homogeneous throughout the brain in typical MRI data.
Therefore, inhomogeneity correction is needed as a major workstep prior to the segmentation of the
different brain tissues. In BESA MRI, this correction is done by an automated workstep realized as an
iterative procedure based on the AFCM algorithm enhanced by incorporating anatomical template masks.
For more details on the AFCM algorithm (Adaptive Fuzzy C-Means) see Pham, D. & Prince, J. (1999), 'An
Adaptive Fuzzy Segmentation Algorithm for Three-Dimensional Magnetic Resonance Images',
Information Processing in Medical Imaging, 140--153.

For adequate results at least 5 to 10 iterations are needed. By incrementing the number of iterations
above the default of 10 iterations the correction can sometimes be improved.

Type Space or press Next to continue.

6.2.1.8. Scalp Segmentation

The reconstruction of the scalp surface is done by segmenting the subject's head from the background
using a level set algorithm. For more details on this algorithm see Chan, T. & Vese, L. (2001), 'Active
contours without edges’, Image Processing, IEEE Transactions on 10(2), 266—277. First, a rough start
mask is constructed by thresholding the image and using subsequent morphological operations. Based
on this start mask, level set segmentation on a coarse computational grid is performed. The result of this
segmentation is then refined using a higher resolution grid.

For the creation of the initial rough start mask, a gray value threshold is used to select all voxels inside
the head with higher gray values and to exclude all outside voxels with lower gray values. As default
threshold for start mask a gray value of 30 is used during automated segmentation. Increase this
threshold to remove artifacts that might be present outside of the head in the segmented scalp. Decrease
the threshold if some parts of the subject's head are not adequately reconstructed in the segmented
scalp.

The default number of iterations is set to 3 for automated segmentation. Scalp segmentation results
may be improved by increasing the number of iterations.
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Both processes, scalp segmentation and refinement have been automated in one segmentation workstep
combining these two substeps. If you want to improve scalp segmentation after inspecting the
automatically obtained results, unpress the Run Segmentation button in the Interaction Window, adjust
the threshold and/or the number of iterations, and press the Run Segmentation button again or type
Space to recalculate this segmentation workstep.

Type Space or press Next to continue.

6.2.1.9. Cortex Segmentation

In this automated workstep the cortical surface is reconstructed in several steps. First, a voxel-based
classification of the white matter is performed. Then, using the level set algorithm again, the surface of
the classified white matter is reconstructed, carefully smoothed and inflated to generate the cortical
surface. This surface can be used as an approximate source space for cortical source imaging, e.g. in
BESA Research.

Currently, cortical surface reconstruction is done by a fully automated procedure not requiring the user to
define specific parameters.

Type Space or press Next to continue.

Note: Cortex segmentation was tested and optimized for a large number of data sets acquired on current
MRI systems. We appreciate your feedback to mri-support@besa.de, if you are not getting sufficient
results with older MRI data sets.

6.2.1.10. Calculate and Verify Results
During this workstep, the final segmentation results are calculated and displayed for inspection.

Before finalizing the output, you may adjust the display settings, i.e. the brightness and contrast values, of
the generated MRI volume data sets if needed. These values have been set to a preset standard during
the segmentation project. If you need to adjust these values, use the controls at the upper right in the
Adjust gray scale section of the Interaction Window. While adjusting, inspect the MRI slices in the Main
Window carefully.

Type Space or press Next or Calculate Output Data in the Interaction Window to continue.

The calculation creates the output MRI volumes in ACPC and Talairach spaces using one direct 3D
spline interpolation of the original MRI data. Surfaces are also calculated for both the ACPC and
Talairach spaces.

You may inspect the results in more detail by selecting one of the ACPC or Talairach Head symbol
buttons in the Set main window display section at the lower right of the Interaction Window. If results
are not satisfactory, you may select any previous workstep in the Workflow Window, modify specific
parameters in the workstep that generated insufficient output, and redo the following worksteps manually
or using automatic finalization. Use the workflow menu on the left to select the workstep to be modified.

Type Space or press Finish to complete the segmentation workflow and create the output data. Follow
the dialogs to save all data of the segmentation project (cf. 6.4.3).

This ends the segmentation workflow and the Select Project page appears offering to start a new project
or open a saved project.
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6.2.2. The Coregistration Workflow

The coregistration workflow provides the coregistration of digitized surface points (electrodes and/or MEG
sensors, fiducials, and skin points) or standard EEG electrodes with an individual MRI data set.
Coregistration is done by marking the 3 standard fiducials (nasion, left and right preauricular points) on
the reconstructed individual scalp surface and fitting the fiducials and selected sensors & skin points to
this surface.

Also, standard electrodes can be matched approximately with an individual MRI. They need to be labeled
according to the 10-20 or 10-10 international system.

The coregistration workflow consists of the following worksteps:

6.2.2.1. Set Project Targets

The first workstep gives an overview over the worksteps that have to be done to complete the loaded
workflow. Grayed tick marks indicate obligatory worksteps, black tick marks relate to optional worksteps.

Type Space or press Next to continue the workflow.

6.2.2.2. Set Fiducials

In this workstep, select an individual subject for coregistration and mark the three fiducials on the scalp
surface.

First, choose an individual subject for coregistration by selecting the related segmentation project. At least
one segmentation project must have been completed for a subject prior to coregistration with MRI.

To select a project, type Space or press Next or Select Input Project in the Interaction Window.

The Select Input Project box opens. Select the subject and one of the projects if several exist. Press OK
to load the selected segmentation data of this subject as input for coregistration.

Next, set the Nasion position. Click onto the surface to set the nasion marker. You may adjust by
dragging the marker with the mouse.

To confirm the position, type Space or press Next or Set Nasion.

The head now turns to show the left side for marking the next fiducial. Click onto the surface to mark the
left preauricular point. You may adjust by dragging the marker with the mouse.

To confirm the position, type Space or press Next or Set Left Preauricular Point.

The head now turns to show the right side for marking the next fiducial. Click onto the surface to mark the
right preauricular point. You may adjust by dragging the marker with the mouse.

To confirm the position, type Space or press Next or Set Right Preauricular Point.

Rotate the head to reinspect the positions of the 3 markers (cf. 6.3.3). Modify, if needed, by unpressing
the required Set ... button in the Interaction Window.
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The figure below displays the completed workstep. The head is rotated to show both the nasion and the
left preauricular markers:
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Type Space or press Next to continue the workflow.

6.2.2.3. Fit Surface Points

In this workstep, fiducials, electrode / MEG sensor positions, and skin points are loaded from a surface
head point file (*.sfh), aligned, and optimally fitted to the loaded individual MRI scalp surface.

Type Space or press Next to load a coregistration file (*.sfh) of the selected subject created when
initiating the coregistration process with a selected EEG or MEG data set (e.g. in BESA Research).

The Open File box comes up. Select the appropriate coregistration file (*.sfh) and open.

After loading the .sfh file, an initial coordinate transformation is calculated to match and align the three
fiducials marked on the MRI scalp surface with the fiducial positions stored in the .sfh file. The loaded
surface positions are displayed using this transformation:
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In the next step, the loaded coordinates are transformed again using shift, rotation and linear 3D shrinking
operations to fit electrodes & surface points optimally to the MRI surface. For this fitting process, only
electrodes and surface points higher than A1/A2 (z >= - 10 mm in the head coordinate system) are used
while a variable elastic bound is attached to the fiducials to preserve their closeness.

To start the fitting process, type Space or press Next or Run Surface Point Fit.

This fitting process uses default parameter settings. Inspect the results by rotating the head and inspect
the positions of the fitted (pink) vs. marked (blue) fiducials as well as the right/left symmetry of the
electrodes when fitting standard electrodes.
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If the coregistration is adequate, type Space or press Finish to complete the coregistration workflow.
Follow the dialogs to save all data of the coregistration project (cf. 6.4.3).
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If not adequate, unpress the button Run Surface Point Fit and change the parameters by pressing
Advanced Settings. This can be done either in the upper section of the Interaction Window (e.g. to
change weights of fiducials vs. electrodes and skin points) or in the lower section (e.g. to modify the
strength of the fiducials bound by restraining to a distance smaller than the default of 2 mm).

You might also want to modify the marked fiducials for better matching. To return to the previous
workstep, press the Previous button or select the Set Fiducials workstep in the Workflow Window on the
left. For example, if standard electrodes appear asymmetric, it may be helpful to modify the position of the
preauricular fiducials to improve the symmetry along with increasing the weight of the fiducials (e.g. to 10)
and decreasing the distance restraint (e.g. to 0.5 mm) in the Advanced Settings of the Fit Surface
Points workstep.

Notes:

1. The loaded coregistration file will be modified automatically after fitting the surface points, i.e. the
current coordinate transformations and MRI output file information are added at the end of the file.
When refitting with modified parameters, it is modified again.

2. If you have several coregistration files of the same subject, e.g. from data sets with different
digitization protocols, you may not want to finish the project but go back to the Set Fiducials workstep
to load each coregistration file and fit the surface points. Thus, each file is modified to contain the
complete coregistration information. When finishing the project, the last file information is stored
together with the project data.
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6.3. User Interaction in Main Window

The Main Window is used to display the results of the current workstep. In addition, it may be used for
user interactions like setting positions in volume data or markers onto surface data. These user
interactions are described in detail in this section.

6.3.1. How to use the Slice Displays

Slice displays are used for depicting MRI volume data. These displays show three orthogonal cross-
sections of the MRI data set, i.e. the transversal (Tra), coronal (Cor), and sagittal (Sag) slices. A red
crosshair line marks the plane where two slices intersect. The slice center is the 3D position where the
three slices — and the three crosshairs - intersect. In the upper row, the three slices are shown fully,
centered relative to the midpoint of the MRI data set. In the lower row, zoomed slices are shown,
centered at the slice center.

Thus, in the upper row, the slice center and the crosshair can be moved by clicking onto the slice or
dragging the crosshair. In the lower row, the crosshair (and slice center) is fixed relative to the display
frame and the slices move when clicking or dragging.

In BESA MRI, several 3D positions need to be set in the volume data (e.g. the AC & PC positions). You
may approximate such positions by clicking on the slice displays in the upper row and do fine adjustments
by dragging the lower slices to the desired position.

Some positions require adjustment only in one dimension, e.g. the setting of the PC position below AC in
the transverse slice or the Rotation of a selected slice. Therefore, the effects of clicking or dragging will
be limited to the allowed dimensions.

When moving the mouse over a slice display, the mouse cursor symbol signals the available interaction
associated with clicking or dragging:

[,‘3 No dragging possible. [}TQ/ Rotate the slice (around fixed mid-position).
- = | Click to set slice center (anywhere in slice). [}‘@‘> Move the slice.

H
Click to move slice center (only up-down). [% Move the slice (only left-right).

="= | Click to move slice center (only right-left). [}7 3 Move the slice (only up-down).
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6.3.2. Setting Markers in Slice Displays

Slice displays can also be used for setting markers at specific positions.

A marker is set in a slice display by a single click onto the desired position in the slice. A marker can be
selected by clicking onto it and it can be moved within a slice by dragging the mouse. Selected markers
can be removed by pressing the Del key.

The mouse cursor symbol specifies which marker interactions can be done at a specific position:

-:- Set marker.

%D+ Select or move marker under cursor.

6.3.3. How to use 3D Surface Displays

The 3D surface displays are used to show the surfaces reconstructed by BESA MRI.

3b

The 3D surface images can be rotated by dragging the mouse. They can be moved / zoomed by dragging
the mouse while holding down the Cirl / Ctrl+Shift key.

A marker is set on a 3D surface by a single click on the desired position on the surface (e.g. to specify
fiducials for coregistration). A marker can be selected by clicking onto it and moved along the surface by
dragging the mouse. Selected markers can be removed by pressing the Del key.

The mouse cursor symbol signals the available interaction associated with clicking and/or dragging:

[é# Rotate 3D image or set marker. [%Q Zoom 3D image.

[}k} Move 3D image. %D'I' Select or move marker under cursor.

-
&
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6.4. Important Dialogs

This section describes important user interactions realized by dialogs.

6.4.1. Select the BESA MRI Data Folder

If required, you may switch to different or create a new BESA MRI Data Folder by selecting the menu
item File > Select Data Folder. In the dialog box below, select an existing folder to store all result data
of BESA MRI or create a new folder accessible to all users in your workgroup (cf. 7.1):

Select the BESA MRI Data Folder

Look jri: | | Projects w | €] T e M-
-1 Mame Size  Type
ty Recent
Documents
(1
Deskiop
ty Documents
'ilJ;-g < >
My Computer
File name:
g Filas of type:
by Metwark, Recent Folders: | Shared D ata Folder w |

Select a folder in this dialog and press OK to set this folder as the current BESA MRI Data Folder.

The Recent Folders selection box at the bottom of the dialog can be used to reselect one of the BESA
MRI Data folders used previously.

By using the Shared Data Folder entry, the default BESA MRI Data Folder can be selected (cf. 7.1).

Note: To create a new folder, select drive and path, press the create folder | * button, then select the
folder, and press OK.

After selecting a new BESA MRI Data Folder, the following confirmation dialog appears:

BESA MRI X

The BESA MRI Data Folder has been selected successfully.
Project data will be written to and read from folder
CADocuments and Settings'all Users\Documents\BESA MRIWProjectsh

Update Data Folder Info

Press OK to activate the new BESA MRI data folder.
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It is recommended to leave the tick mark on to update all existing projects in the new BESA MRI Data
folder, if you switch between folders (cf. 7.1).

Note: When switching between different BESA MRI Data folders, the project data are preserved in each
folder and are not copied to the new folder.

6.4.2. Open Projects

Projects can be opened by pressing Open Segmentation Project or Open Coregistration Project in
the Select Project Page (cf. 6.1.2) or by selecting the menu item File 2 Open Project.

The project type to be opened is displayed at the bottom of the Open Project dialog box shown below and
may be modified using the Project Type dropdown list:

Open Project g|
Subjects Projects
Subject 20 (1970-01-01) ~|

Subject 21 (2000-01-02)
Subject 22 (Unknown DOB)
Subject 23 (1963-03-12)
Subject 24 (2002-07-14)
Subject 25 (1974-12-11)
Subject 26 (1967-12-27)
Subject 27 (1980-08-12)
Subject 25 (1975-10-09)
Subject 29 25)
Subject 30 (1911-11-01)
Subject 31 (1977-07-22)
Subject 32 (1968-11-27)
Subject 33 (1979-04-19)
Subject 34 (Unknown DOB)
Subject 35 (1977-08-09)
Subject 36 (1971-11-04)
Subject 37 (1973-03-06)
Subject 38 (2001-09-24)
Subject 39 (1985-01-01)
Subject 40 (1978-05-07)

Selected Subject: | Subject 29 (1980-07-25)
Selected Project: |MRI_TI
Project Type: Segmentation Projects v

Projects are stored under subject name and birth date. First, select the desired subject clicking on the left.
If different projects exist for this subject, select the desired project by clicking on the right.

Press Open.

6.4.3. Finish, Save and Close Projects

6.4.3.1. Finish a project

The last step in any workflow is finishing the project by typing Space or pressing Finish. This last action
ensures that the project data with all result files are stored in the BESA MRI Data Folder.

The Save Project As... dialog box comes up proposing a project name, if the project is new (see figure
below). If a previous project has been opened and modified, the previous name is proposed.

The selected subject and proposed project names are highlighted automatically. To save under a different
project name, enter a new project name in the Selected Project edit field.

Press Save to store the project data including all volume and surface data sets.
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@ save Project As...

Subjects Projects

MRI_T1

Subject 30 (1511-11-01)
Subject 31 (1977-07-22)
Subject 32 (1968-11-27)
Subject 33 (1979-04-19)
Subject 34 (Unknown DOB)
Subject 35 (1977-08-09)

Subject 36 (1571-11-04)

Subject 37 (1973-03-06)

Subject 38 (2001-09-24)

Subject 39 (1985-01-01)

Subject 40 (1978-05-07)
Subject 41 (1246-04-01)
Subject 42 (1854-10-31)
Subject 43 (1947-02-06)
Subject 44 (1985-03-12)
Subject 45 (1965-01-25)
Subject 46 (1976-12-20)
Subject 47 (1979-09-29)
Subject 48 (1285-03-03)
Subject 49 (1866-03-27)

Selected Subject: [Subject 29 (1980-07-25) I

Selected Project: H Cancel ]

Project Type: |Segmentatinn Frojects ‘

If the selected project name does not yet exist, the project is saved with all result files automatically.

If you keep the highlighted project name of a previous project or select another previous project name of
the current subject in the Projects selection box on the right, you will be asked whether to replace the
previous project by the new project data:

Save Project As...

!

The project COR__Subject 071 (1960-01-01)_MRI_T1__BESA MR
Av33 cor already exists.
Do you want to replace it?

Press Yes, if you want to discard the previous project data and store the new data under the previous
project name.

Press No, if you prefer to save under a different project name. The Save Project As... dialog box comes
up again.

This workstep is complete when the Select Projects page comes up again offering to select another
project or exit the BESA MRI program.

Note: You may get to the Save Project As... dialog box at any time during the workflow using the menu
item File > Save As, e.g. if you want to store the current data preparation under a specific project name
to be completed later by Automatic Finalization.

6.4.3.2. Close a project

At any time during the workflow, you may close the current project using the Close button in the toolbar
or the menu item File > Close.
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When closing a project, the following dialog box comes up:

Save Project

Do you want to save the changes to project
COR__Subject 01 (1960-01-01)_MRI_T1_BESA MRI AV33 cor?

- —n

e ) [ [(Ganee

Press Yes to save the changed project data. Previously stored data will be overwritten.

Press No if you want to discard all changes, e.g. when accidentally modifying user defined parameters
during reinspection after opening an existing project. In this case, the stored data of the current,
previously saved project will not be overwritten and changes to the project will not be stored.

Press Cancel to return to the project workflow, e.g. if you want to save the current changes under a new
project name using the menu item File - Save As.
6.4.3.3. Save a project

At any time during the workflow, data can be saved by selecting the menu item File > Save or typing
Ctrl+S. However, previously stored data will be overwritten automatically.

Notes on closing and saving:

1. Closing and saving can be done at any time during the preparation of a project to preserve the user
input up to the completed workstep.

2. If a previously completed project has been opened, previous project data will be overwritten and
replaced by the current state of the project. Therefore, do not use the save function when opening a
previous project simply for inspection. In this case, use the menu item File &> Save As.

Select the menu item File - Save As to store a modified project under a new project name.

The current project state and name can always be seen in title bar.
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6.4.4. Delete Projects

Stored BESA MRI projects can be deleted if no longer needed, e.g. if an improved coregistration project
has made a previous project obsolete. To delete, select the menu item File > Delete Projects... . The
Delete Projects dialog box appears:

Delete Projects...

Subjects Projects

Subject 20 (1970-01-01) ~
Subject 21 (2000-01-02)
Subject 22 (Unknown DOB)
Subject 23 (1963-03-12)
Subject 24 (2002-07-14)
Subject 25 (1974-12-11)
Subject 26 (1967-12-27)
Subject 27 (1980-08-12)
Subject 25 (1975-10-09)
Suhje 5
Subject 30 (
Subject 31 (1977-07-22)
Subject 32 (1963-11-27)
Subject 33 (1979-04-19)

{

(

(

1811-11.01)

Subject 34 (Unknown DOB) —
Subject 35 (1977-08-09)
Subject 36 (1971-11-04)
Subject 37 (1973-03-05)
Subject 38 (2001-09-24)
Subject 39 (1985-01-01)
Subject 40 (1978-05-07) e

| >

|~

Selected Subject: [Subject 29 (1980-07-25) || Delete |

Selected Project: |\_T2_Standard-81 [COR Project); MEILT1 (SEG Project); MRI_T1_2 (SEG F'I’DJECU‘ [ Cancel ]

Project Type: |AII Projects v‘

In the Project Type drop down selection box at the bottom, select the type(s) of projects to be deleted.
Select Segmentation Projects to delete segmentation projects, Coregistration Projects to delete
coregistration projects, or All Projects to delete segmentation and coregistration projects.

Mark all subjects for whom project data shall be deleted in the Subjects selection box. Then select the
projects to be deleted in the Projects selection box (multiple subjects or projects can be selected by
holding the Ctrl or Shift key while selecting).

A confirmation box is displayed, after selecting and pressing Delete.

Press Yes only, if you do not need the listed project data any more. Restoring is no longer possible after
deleting. Press No to prevent deleting.
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6.4.5. Select Files

When selecting input data (e.g. original MRI DICOM data for segmentation or a coregistration file), the
following dialog appears:

=) Open File
Look in: | £ Subiect 02 v @ E-
3 Mame Size | Type ~
1_-‘5 = soaas7as 201KE File
My Recent | | [ sas4sa00 201K File
Documents | | e aosasars 201K File
— | avaasazz Z01KE File
L% = Bvaasasa Z01KE File
Deskiop =] momasaes 201 KB File
0 201 KB File
=] soz4sa9s 201 KE File
.’/' EEEEH 201 KE File
My Dacuments || [5]99845328 201K File
B Z01KE File
. B Z01KE File
I;WJJ,! Hﬂqﬂdqq?ﬁ PN KR File v
L < >
ty Computer
File niame: | 345880 v [Coeen ]
.,.,;l Files of ype: [ Al DICOM Files 1) v [Ccenea
-
My Metwork Recent Folders: |E SDICOMYSubject 014 v|

Use the drop down folder list at the top to navigate to the desired input folder. Then, select a file in the
current folder and press Open.

Use the Recent Folders selection box at the bottom to open a folder previously used for input to speed
up navigation.

41






1) BESA

7. Appendix

For an easy data management, the data generated by BESA MRI are stored in one folder. In this folder,
the so-called BESA MRI Data Folder, the data are organized in subject-based subfolders.

7.1. The BESA MRI Data Folder

The BESA MRI Data Folder is the folder or path where BESA MRI stores all project data to and reads
completed or prepared projects from. This folder should exclusively be used for storing BESA MRI data.

When starting BESA MRI for the first time (cf. 3.2.3), a local folder accessible to all users is suggested as
the default folder. Depending on the operating system, this folder is located as follows:

e Windows 7:
e Windows Vista:
e Windows XP:

In most cases, however, it might be more useful to create a shared folder on a server drive, e.g.

that is accessible to all users from anywhere in the local network. This is more
convenient, since BESA MRI uses a network dongle allowing the software to be run from any computer in
the local network where BESA MRI has been installed and configured with the shared BESA MRI Data
folder (cf 3.2.3).

Note: If you have a multi-license installation, make sure that two user do not work on the same subject
and project at the same time. Currently, BESA MRI does not lock projects within the network.

If there are several major research studies with different subjects, you might want to create separate
folders to store the data of the different studies separately. BESA MRI offers the choice to switch between
different BESA MRI Data folders (cf. 6.4.1) by selecting the menu item File > Select Data Folder.

Note: When switching between different BESA MRI Data folders, the project data are preserved in each
folder and are not copied to the new folder. Thus, you may have to segment a subject's MRI twice unless
you copy the subject’s subfolder to the new BESA MRI Data folder using, e.g. Windows Explorer, and
update the Data Folder Information as described below.

7.2. The BESA MRI Data Folder Information File

For faster access on the different projects in the BESA MRI Data folder, an information file called Data
Folder Info is created in the subfolder within each BESA MRI Data folder. The Data Folder
information stores the subject and project file names of all projects in the BESA MRI Data folder.

After copying or moving subject data folders from a previous to a new BESA MRI Data folder using, e.g.
Windows Explorer, update the Data Folder information by selecting the menu item File > Update Data
Folder Info. When switching between folders, make sure that the tick mark of the update option stays on
in the confirmation dialog box (cf. 6.4.1).
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7.3. Subject-based Data Management

Project data are stored on a subject name basis. Subjects are identified by family name, first name, and
birth date as read from the input files (DICOM). If a subject name is not known, e.g. if the MRI data have
been anonymized, the default subject name Z_Anonym is used. If the birthday is not specified, the
default birthday 1901-01-01 (Unknown DOB = unknown date of birth) is set.

All project data of a subject are stored in one subfolder of the BESA MRI Data folder having the
composed folder name .

Project data are managed by BESA MRI using special dialogs for opening, saving or closing, and deleting
projects (cf. 6.4.4). These dialogs provide a subject-and project based selection of completed or prepared
project data.
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